
Alarming Events™

30 Day Demo
for Apple® Macintosh® Computers

Program by
Serge Froment

Informagique, Inc.

Manual by
Luke Lund

Product Manager
Jeff C. Knee

CE Software, Inc.
P.O. Box 65580

West Des Moines
Iowa  50265  USA

(515) 224-1995

Copyright © 1990 CE Software, Inc.  All Rights Reserved.

Alarming Events is a trademark of CE Software, Inc.
All other brands or product names are trademarks or registered trademarks of their respective holders.

Chapter 1:  Introduction to Alarming Events



Alarming Events™ is a desk accessory that helps you “keep ahead of the game.”  In our 
fast-paced world, it is vital that you manage your time.  

Alarming Events lets you create appointment files and schedule events within them.  
When the time for an appointment occurs, Alarming Events reminds you.  

Do you keep losing your list of important tasks to complete?  Alarming Events also 
provides an electronic “To Do” list.  To Do items are carried forward in your schedule from 
day to day until you mark them as done.

Three basic windows provide different views into your appointment file.  The Calendar 
window can be reshaped to display one month, one quarter or a full year.  The Five Day 
window provides a glance at the workweek ahead.

You can view any date with the Single Day window.  It provides a detailed look at the daily
lineup of activities.  It is also used to enter new tasks and appointments into your 
appointment file and determine how, or if, you want to be reminded of the event.

Notification for an event can appear in several ways.  You can assign it to quietly flash a 
small icon in the corner of your screen, reminding you to open Alarming Events and see 
the reminder.  If it’s an important event, you can assign it to demand your immediate 
attention by interrupting your work and opening directly over your application.

From the Notification window you can mark the event as done, postpone the reminder, 
reschedule the event, archive it or delete it.

When events are archived, they create a retrievable log of things you’ve accomplished.  

If you have someone else setting up appointments for you, they can be given access to 
your appointment file(s) and can set your schedule.  You can create multiple appointment 
files and archives to schedule and record business, personal and other types of events.  

You can access Alarming Events through the Apple menu or by pressing two different “hot
keys.”  You can alter the hot keys to any combination you like. 

Alarming Events appointment files can be exported into other programs such as 
CalendarMaker™ (also from CE Software) to print out calendars with your events listed.

You can also import files such as CalendarMaker, SmartAlarms™ and text files to quickly 
compile lists of events into your appointment files.

Requirements
To use Alarming Events you will need a Macintosh Plus, SE, SE/30, Mac II, IIci, IIcx, IIfx 
or Macintosh Portable with at least 1 megabyte of memory, running System 6.0.2 or 
higher.  A hard drive is required.





Installing Alarming Events

To install Alarming Events:

1)   Open the Finder on your Macintosh.  Pull down the Apple menu and select  “About the
Finder”.  The information box that appears will tell you which version of the System you 
are using.  You must be using System 6.0.2 or higher.

2)   Lock the Alarming Events disk by sliding the locking tab to expose the square hole.

3)   Open your System Folder and see if it contains a file called CEToolbox.  If it does, 
click once on its icon (it will darken) and select “Get Info” from the File menu.  Examine 
the information box that appears to learn the version number of the CEToolbox you 
currently have installed.  Make a note of the version number.  

If you don’t have CEToolbox in your System Folder, don’t worry.  We’ll install it shortly.

4)   Insert the Alarming Events disk into a drive slot.  Click once on the CEToolbox icon 
and select “Get Info” from the File menu.  Look at the window that appears to learn the 
version number of the CEToolbox on the disk.  You need to use the newest (highest-
numbered) version of CEToolbox when installing Alarming Events.  (You must be using 
CEToolbox version 1.4 or higher.)

5)   Copy the “Alarming Events Archives,” “Alarming Events File” and “Notification 
Toolbox” into your System Folder.  

If the “CEToolbox” on the Alarming Events disk is newer than the one currently in your 
System folder (or you don’t have CEToolbox in your System Folder), copy it from the disk 
to your System Folder.

6)   Double click on the Alarming Events suitcase icon to open Font/DA Mover.  The 
Font/DA Mover dialog box will appear.

7)   Click the “Open” button under the right scroll bar field and use the Open dialog box 
that appears to open your System folder and the System document within that folder.

The names of the desk accessories already installed on your Macintosh will be listed in 
the right scroll bar field.  

8)   Click on “Alarming Events” to select (darken) it and click the “>>Copy>>” button.  

If you are running MultiFinder™, a dialog box will appear stating you need to restart your 
Macintosh before Alarming Events will work. 

9) Click the “Quit” button and restart your Macintosh.



Three Basic Windows

Using Alarming Events, you create appointment files (similar to an appointment book). 
The three basic windows, the Calendar window, the Single Day window and the Five Day 
window are used to view and modify the selected appointment file and keep you posted of
upcoming appointments and items on your To Do list.

Select “Alarming Events” from the Apple menu.

CALENDAR WINDOW
The Calendar window will appear displaying two months.  Today’s date is outlined by a 
small square.  Dates that have events scheduled (either appointments or To Dos) will be 
shown with bold numerals.

Note:  If you’ve just installed Alarming Events, no dates will be boldfaced in the Calendar 
window and the fields in the Single Day and Five Day windows will be blank.

If the date in the square is not today’s date, open the Control Panel desk accessory, 
select the General icon and reset the Date field to today’s date.  Click the Close box in the
upper left corner to close the Control Panel.

You can drag the Size box in the lower right corner of the Calendar window to reshape it 
to display more months or to stack the months vertically.  You can reshape and resize the 
window to fill your entire screen.  

Clicking the Zoom box in the upper right corner will reshape the Calendar window to 
display a full year.

The current time (as set in the General Control Panel window) is shown beneath the right 
end of the title bar.   As with the date, you may reset the time through the Control Panel. 

If you need to see months in the future or in the past, click the arrows on either side of the
Calendar icon in the title bar.

SINGLE DAY WINDOW
Click on today’s date in the Calendar window.  The Single Day window will be shown.  It’s 
used to set up appointments and to post items in your To Do list.

You can click on an event in the “List of Events” field to see any details for it in the “Events
Note” field.
 
The Single Day window also shows a calender.  You can change the month shown by 
clicking on the left or right arrows by the month name.

From either the Single Day window or the Calendar window, you can open the Five Day 
window by holding down the Shift key and clicking on the first of the five dates you wish to
see.  While in the Single Day window you can press Shift-Return to open the Five Day 



window.

Five Day Window
The Five Day window lets you see your schedule for the next five days.  

If you click on any of the events listed in any of the date boxes, notes you have posted 
concerning that event will be shown beneath the fifth date box.

If you double-click on an entry, the Single Day window will appear with the data of that 
event listed in the fields.  This allows you to easily edit the event.

You can close any of the windows by clicking the Close box in the upper left corner.  

Notification

Setting up a schedule is only half of the job.  Reminding you of what you need To Do or 
where you need to be is the job of the Alarming Event’s notification features.

When the scheduled time for an event occurs, Alarming Events notifies you in one of 
several ways.

If the Pop-up Alarm was selected when the event was created in the Single Day window, 
a dialog box will appear on your screen.  (You will also hear an audible signal if your 
Notification preferences are set to use sounds at notification time.) 

The name of the currently selected appointment file appears at the top of the Notification 
pop-up box.

If the Flashing Alarm was selected when the event was created, an Alarm Clock icon will 
flash over the Apple icon in the upper left corner of your screen.  (If your preferences are 
set to use sounds, you will also hear the chosen notification signal.)  A flashing icon 
prompts you to open the Alarming Events Calendar window.

A dialog box will open over the Calendar window.

In both the pop-up box and the dialog box, the Event Action icons to the right of the notes 
area allow you to check the event as done, postpone the notification, open the Single Day
window, archive the event or delete the event.

Now let’s learn how to set up an appointment or event with Alarming Events.

Setting Up Events - A Short Tutorial 

1)   Pull down the Apple menu and select “Alarming Events” or press Command-Option-T. 



The Calendar window will appear.  Click on today’s date or press the Return key to 
display the Single Day window for today’s date.

2)   Type “Alarming Events Lesson” in the Event Subject field.  The date and time fields 
will appear above the Event Subject field with the hour numerals highlighted. 

3)   You can alter the numerals shown by clicking on them and then clicking the up and 
down arrows or by typing.  (Pressing the Tab key will shift the highlight forward to the 
minutes place.  Pressing it again will shift it to the AM/PM  place.)  

     Change the time to when the event will begin.  For our example, set the event to begin 
five minutes from now.  (Change the AM/PM field by typing an “A” or a “P” when it is 
highlighted.)

4)   Press Tab until the insertion point is flashing in the Event Notes field.  Type in 
“Continue reading about Alarming Events.”

5)   Press the Tab key and the insertion point will move to the Duration field.  The time 
entered here will be automatically added to the starting time for this event.  This helps you
block time in your schedule.  

     Type in “20” and click on the “minute” box.  It is actually a pop-up menu.  If an event 
required more time (hours, days, weeks, months or even years) you could select it from 
this menu.  Select “minute” for this example.

6)   Click on the Alarm Clock icon in the Duration field.  A small box will appear showing 
when this event will be completed.  (Duration time added to the starting time equals the 
completion time.)

7)   Press Tab again to move to the Advance Notification field.  Type in “2” and select 
“minutes” from the pop-up menu.  If  you click the Alarm Clock icon in the Advance 
Notification field, a small box will appear telling you exactly when the advance notification 
will be given.

8)   Press Tab.  The insertion point will shift to the Recurring Interval field.  This field is 
used to set up regularly scheduled events.  For our example, we’ll leave it blank.  

9)   Click on the pop-up menu above the Duration field and select “Flashing Alarm”.

10) Click the “OK” button or press the Enter key.  The Subject, Notes, Duration and 
Advance Notification fields will clear and the List of Events field will display this 
appointment.

11) Click the Close box in the upper left corner of the Single Day window.  The Calendar 
window will be frontmost again.  Today’s date will be shown in bold numerals, indicating 
there is an event scheduled.



12) Press the Shift key and click on today’s date.  The Five Day window will appear, listing
your new event in the first date field.  Click on the entry and the notes for the entry will 
appear beneath the fifth date field.

13) Click the Close box to return to the Calendar window.

14) Click the Close box in the upper left corner of the Calendar.  Wait for the notification to
alert you of your event. When you hear the notification signal and see the Alarm Clock 
icon flashing over the Apple icon, select “Alarming Events” from the Apple menu.

     The Calendar window and an alert box will  appear.

     Click the Trash Can icon at the right side of the alert box to delete the message.

APPOINTMENT FILES AND ARCHIVES

When you schedule an event (through the Single Day window) the information about that 
event is stored in an appointment file.  Many users will only need and use the Alarming 
Events appointment file that you placed in the System folder when you installed Alarming 
Events, but you may wish to create others - either for other people if you share your 
Macintosh or for other types of events, such as birthdays, vacation schedules, etc.  

Once created, you can select the appointment file you wish to use from the sub-menu that
appears when “Appointment Files” is selected from the Alarming Events menu.  

The selected appointment file is identified by a check mark in the sub-menu and 
whenever a notification dialog box appears, the appointment file is named in the title bar.

When a different appointment file is used, you’ll notice that different dates in the Calendar 
window are highlighted and the list of events in the Single Day and Five Day windows 
only show events that are stored (scheduled) in that appointment file.

Appointment files can be printed to produce a hard-copy record of your upcoming events.

Archives are used to keep a record of appointments and tasks (To Do items) you have 
completed.  Events are added to the currently selected archive by clicking the Archive 
icon in the Notification pop-up or dialog box or by selecting the event in the List of Events 
in the Single Day window and clicking the “Archive” button.

Archives can be printed to generate a hard-copy report of what you have accomplished.  

Once created, you can select the archive you wish to use from the sub-menu that appears
when “Archive Files” is selected from the Alarming Events menu.  The selected archive is 
identified by a check mark in the sub-menu.



Those are the basics of Alarming Events.  There are other options that provide flexibility 
and power and help you take charge of your schedule.  Follow the advice of your Advance
Notification dialog box and continue reading the next chapter.  



Chapter 2:  A Closer Look

In this chapter we will examine the features of Alarming Events in detail.  We will look at 
the windows, the notification features and the items in the Alarming Events menu and 
discuss how you can put them to the greatest use.  

The Calendar Window

Besides selecting Alarming Events from the Apple menu, you can open the Calendar 
window by pressing the hot key.  The default hot key for opening the Calendar window is 
Command-Option-T.  You can change this “hot key” from the General Preferences dialog 
box.

The first time the Alarming Events desk accessory is opened, the Calendar window will 
appear displaying two months - the last month and the current month.  The current date 
will be outlined by a small square.  

Note:  If the date in the square is not today’s date, open the Control Panel desk accessory
to the General window and set the date shown to today’s date.

Later, after some events have been scheduled, those dates that have either appointments
or To Dos in their list of events will be shown with bold numerals.

You can change the size and shape of this calendar to show more months or only one 
month.  Click and drag the Size box in the lower right corner to see more months. 

Clicking the Zoom box in the upper right corner will reshape the window to display a full 
year.  Clicking it again will return the window to its previous size.

The year shown is listed below the title bar.  If the months of more than one year are 
shown, the year spread will be listed, such as 90-91 or even 90-92.  Clicking on the right 
or left arrows on either side of the listed year will display months from years in the future 
or in the past.

To the right of the year is the calendar icon.  Clicking the right or left arrows on either side 
of the icon will display the next or the previous months.  Clicking directly on the calendar 
icon while holding down the Option key will display a small box stating how many events 
are scheduled in the currently selected appointment file.

The current time (as set in the General Control Panel window) is shown at the right end of
the title bar.

If the Calendar window is wide enough and you have at least one appointment scheduled 
on a future date, the subject of the next appointment will be shown below the left end of 
the title bar.  (To Do items will not be listed in the title bar.)



The Single Day Window

If you click on any date in the Calendar window, the Single Day window for that date will 
be shown.  If you press the Return key while the Calendar window is open, the Single Day
window for today will open.

The Single Day window is used to schedule appointments and list tasks to be done (To 
Do items).

The calendar in the Single Day window behaves like its counterpart in the Calendar 
window.  You can click on the right and left arrows to see different months.  (People with 
monitors screens that are larger than nine inches will see a picture of a tree in the Single 
Day window.  The tree, if shown, will change with the month.)   Clicking on a date will 
open the Single Day window for that date.  If you hold down the Shift key while clicking on
a date, the Five Day window will open displaying a list of events for that and the next four 
dates.

The day, month, date and year are listed in the title bar.  After clicking the “New” button, 
the date also appears above the Subject field.  Events shown in the List of Events window
are scheduled to occur on the date shown (in the title bar).  If new events are created, 
they will be inserted into the appointment file on the date shown.

To shift to a different date you can click on a date in the calendar or you can type a 
different date in the Date field or click the up and down arrows in the Date field when the 
numerals in the Date field are active (shown in inverse).

Scheduling an event
Events are scheduled by filling in and setting the various menus and fields. You can move
from field to field in the window by clicking in the different fields or by pressing the Tab 
key.  Pressing the Tab key will cycle through the fields in this order:

Hour, Minutes, AM/PM, Subject, Notes, Duration, Advance Notification, Recurring Interval,
Month, Date, Year, Hour, Minutes, etc.

If you hold down the Shift key while pressing the Tab key, you can cycle through the fields 
in reverse order.

Set the time field to the time when your event will begin.  You can do this by selecting and 
typing in the hours, minutes or AM/PM field or by clicking the up and down arrows when 
the desired field is active.

Use the Event Subject field to enter the subject or name of your event.  You can use up to
35 characters in the Event Subject field.  When the Five Day window is open, only the 
subject of each event will be shown.
Use the Event Notes field for more details about the event.  You can use up to 254 
characters to describe your event in this field.  When the Pop-up Notification box opens, 
the subject and the notes will be shown.



The pop-up Alarm menu is used to set the type of notification you wish for an event (if 
any) or to mark an event as done.

Pop-up Alarm - will cause a notification sound to be heard and a pop-up window to appear
over any open document or desk accessory when the notification time occurs.  This type 
of notification is intended to interrupt your work and make sure you don’t forget an 
important event.  

The pop-up contains the subject and the notes for the event.   The currently selected 
appointment file is named above the date. 

You can click the Event Action icons to mark the event as done, postpone the event or 
notification, consult today’s Single Day window, archive the event or delete the event.  

The “OK” button can cause different actions to occur, according to the preferences 
selected on the Notification Preferences dialog box that is available through the Alarming 
Events menu.

Flashing Alarm - will sound an alarm noise and cause the Alarming Events icon to flash 
over the Apple icon in the upper left corner of the screen.  When you see the icon flashing
and/or hear the noise, open Alarming Events to see the Notification dialog box.

The Notification dialog box shows you the subject and notes for the event.  The Event 
Action icons allow you to mark the event as done, postpone the event or notification, open
the Single Day window, archive or delete the event.  The Help icon produces a detailed 
description of the function of each icon.

Note:  You can turn off the sound or the flashing icon used with the Flashing Alarm.  Also, 
you may choose the alarm noise you wish to use from the Notification Sounds menu in 
the dialog box that appears when “Notification Preferences” is selected from the Alarming 
Events menu.

Timed Event - will not give any notification (no flashing icon or sound), but  when Alarming
Events is opened, a dialog box containing the time, subject and notes for the event will be
shown. 

To Do -  To Dos do not have any notification features.  They simply remain present in the 
list of events in the Single Day and Five Day window and are carried forward day to day, 
until they are marked as done.  To Dos can be listed with a Duration time and, if they are 
more than 1 day old, are listed with their “age” (2 days old, 5 days old, etc.).
Done - is selected to mark a To Do item or appointment as done and remove it from the 
list of events.

Duration  The Duration field is used to enter your estimate of how long this event will take 
to finish.  Type a number in the field and select minutes, hours, days, months or years 
from the pop-up menu.  



If you click the clock icon in this field, a small box will appear indicating when this event 
will be completed.  (Alarming Events adds the duration time to the starting time and 
displays the finish time.)

The duration will be displayed as a time spread in the List of Events, such as 3:00-3:45 
PM.  

Advance Notification  The Advance Notification field is used to enter the time you need to 
prepare for or travel to an event.  Type a number in the field and select minutes, hours, 
days, weeks, months or years from the pull-down menu.  If you click the clock icon in this 
field you will be shown the time at which the advance notification will occur.  When the 
time for the Advance Notification occurs, you will be signaled according to the type of 
alarm you have chosen.  

Recurring Interval  The Recurring Interval field is used to set up recurring appointments 
on a regular basis.  Type the number of minutes, hours, days, weeks, months or years 
between the appointments and select the correct unit of time from the menu.

If the interval selected is “week”, the “Keep Day of Week” box will be automatically 
checked.  (Thus an event originally scheduled on a Thursday would always recur on a 
Thursday.)  If the interval selected is “month” or “year”, the “Keep Day of Week” and 
“From End of Month” check boxes will become active and may be checked.

Here are some examples of recurring appointments:
If you have a standing date to play tennis with your boss the second Saturday of each 
month, type a “1” in the box, select “month” and check the “Keep Day of Week” box.

If you see your dentist for a checkup every three months on the fifteenth day, type a 3 in 
the field, and select “month”.  Don’t check either box.

If a monthly report is always due two days before the end of the month, Type a “1” in the 
box, select “month” and check the “From End of Month” box.  Alarming Events will 
automatically adjust the event for months of 28, 29, 30 or 31 days.

Events using the Recurring Interval field will automatically be added to your list of events 
on the appropriate days.  

Note:  Recurring Events do not cause the dates on which they are scheduled to be 
boldfaced, except for the date when they are originally entered, or if that date has passed,
the next time the event will occur.

You can click on the Clock icon in the Recurring Interval field to see the next time this 
event is scheduled.

After filling in the fields correctly, click the “OK” button.  The List of Events in the Single 
Day window will show the new event.



List of Events  The List of Events field displays events that have been scheduled for that 
date.  Each event’s entry is identified with an icon corresponding to the type of notification
used for it, as well as the subject, beginning time and completion time.  To Do items may 
display an estimated time required to complete the task and the number of days the item 
has been carried forward (remained “undone”).

Editing a scheduled event
The List of Events field shows the appointments and To Do items that are already 
scheduled for this day.  To edit an existing event, click on it in the list of events.  The event
will be highlighted and its entries will be shown in the various fields.  You may change any
of the fields or delete or archive the event by clicking the buttons.

Rescheduling an event
If you need to reschedule an event, simply select the event in the List of Events field (in 
the Single Day window).  The fields will display the data for that event.  Change the date 
or time field and click the “OK” button.  

The event will be removed from the original date and placed on the new date.  All 
notification data attached to the event for the original date will be transferred to the new 
date. 

Command key equivalents  
If the Command key is held down, the buttons will be shown with their Command key 
equivalents.  Instead of clicking the buttons, you may press the Command key and the 
character key shown on the button.

The Five Day Window

If the Shift key is held down, the currently selected date in the Calendar window will be 
outlined along with the four following dates.  Clicking any date in the calendar with the 
Shift key held down will open the Five Day window, starting with the date clicked.  You 
may Shift-click any date shown in the calendars of the Calendar, Single Day or Five Day 
windows to open the Five Day window for those dates.

The Five Day window is used to display what’s ahead on your schedule.  The subject and 
the beginning and completion times are shown along with the icon of the alarm chosen for
the event.

Click once on a listed event to display the subject and notes for that event in the area 
beneath the fifth date box.

Double-clicking on any entry in any of the dates shown will display the Single Day window
containing that event.  The event will be selected and its entries displayed in the fields for 
easy editing.



You may see other Five Day windows by clicking the date desired in the three calendars.  
As with the other calendars, clicking the right or left arrows will show different months.  

Notification 

When the time for a scheduled event arrives, you’ll be notified according to the option you
selected from the Alarm menu when the event was created.  

The Notification pop-up window will appear directly if “Pop-up Alarm” was selected. 

If you selected “Flashing Alarm”, you may hear the notification sound and/or see the 
flashing icon.  The Notification dialog box will appear when you open Alarming Events.

The Notification dialog box may be labeled “Event Notification” or “Advance Notification”, 
depending on the type of alarm selected when the event was entered in the Single Day 
window.

Both the Notification pop-up window and the Notification dialog box list the date and time 
of the event, along with the subject and notes listed for the event.

Event Action Icons
The Event Action icons in the window allow you to do the following:

Clicking the Alarm Clock icon will close the Advance Notification pop-up or dialog box.  
This icon appears undimmed only when advance notification is used.

Clicking the check mark icon will mark this event as done.  Clicking the Check Box icon 
will cause this event to be marked as done in the Events file.  The pop-up window or 
dialog box will close.

Clicking the Clock icon will postpone notification for the event.  Clicking the Clock Dial 
icon will open a dialog box that can be used to set the pop-up window or dialog box for 
this event to reappear at a later time.   

In the Postpone Notification dialog box, select the “For:” button to postpone for a number 
of minutes, hours, days, etc., as selected from the pop-up menu, or select the “Until:” 
button and click a date in the calendar area and reset the time field to postpone to a 
specific date and time.

Clicking the Calendar icon will open the Single Day window for the date on which this 
event occurs.  Clicking the Calendar icon lets you check the itinerary for the day, edit any 
existing events or create new ones.

Clicking the Disk icon will Archive the event in the currently selected archive file.

Clicking the Trash Can icon will delete the event from the Alarming Events files and close 



the pop-up window or dialog box. 

Clicking the Help icon will display a box listing these icons.  Move the cursor over the 
icons and the function of that icon will be listed at the bottom of the box.

Appointment Files 

When an event is scheduled, the entry is stored in an appointment file.  You may find it 
easier to think of these files as appointment books. You may wish to have more than one 
appointment file.  Besides business appointments, you might build one containing only the
birthdays of co-workers and friends, one for personal appointments, possibly another to 
track when your fellow employees are taking vacation.

Alarming Events lets you create and store up to 30 different appointment books on your 
hard disk.

Creating extra appointment files
When you installed Alarming Events you placed a single appointment file, called 
“Alarming Events File”, in your System Folder.   Any events you have created this far are 
stored in that file (unless they have been deleted).  

To create additional appointment books:

1)   Open Alarming Events.

2)   Pull down the Alarming Events menu and hold the mouse button down with the cursor
on “Appointment Files”.  The sub-menu will appear.  

3)   Slide the cursor down and release the mouse button when “Edit Menu…” is 
highlighted.  The Edit Appointment File Menu dialog box will appear.

4)   Click the “New” button.  The Save New File As: dialog box will appear.  Type in a 
name and use the buttons and folders to select a location for the file.  Click the “Save” 
button.

5)   The Edit Appointment File Menu dialog box will reappear with your new appointment 
book highlighted and its hierarchical location shown in the lower window.

6)   Click the “Done” button to close the Appointment File dialog box.  The new 
appointment book will be listed in the Appointment File sub-menu.

Switching Appointment Files
To switch to a different appointment book, simply select it from the Appointment File sub-
menu.  The current appointment book is identified with a check mark.



After you switch to another Appointment book, you will notice that the dates highlighted in 
the Calendar window and the events listed in the Single Day and Five Day windows will 
reflect the events posted in the new appointment file.

Adding Appointment files to the sub-menu
To add another file to the Appointment Files sub-menu, open the Edit Menu dialog box, 
select the file you wish to add and click the “Add” button.  Using the Drive button and the 
folders in the Open dialog box, locate the file you wish to add to the menu.  Double-click 
the file.  The Edit Appointment File Menu dialog box will reappear with the file listed.  Click
the “Done” button.

Removing appointment files
To remove an appointment file from the Appointment Files sub-menu, open the Edit 
Appointment File Menu dialog box, select the file you wish to delete and click the 
“Remove” button.

Locating Appointment files
If an appointment file has been moved into a different folder or renamed, its name will be 
dimmed in the Appointment File sub-menu.  It cannot be used until you identify the new 
name or location with the “Locate” button.

Open the Edit Appointment File Menu dialog box, click on the dimmed file name and click 
the “Locate” button.  A Find File dialog box will appear.  Use it to find and highlight the file.
Click “Open”.  If the file was renamed (at the Finder), the new name will now appear in the
Appointment File sub-menu.

Combining Appointment files
To add another appointment file to your current appointment file, select “Import Events” 
from the Alarming Events menu.  Use the Open dialog box that appears to locate and 
open the file you wish to add.  The files will be combined and the windows will show the 
events of the added file.



Archiving Events

Besides keeping a record of things you need to do, Alarming Events can also maintain a 
record of what you have done.  If you archive your events when they are completed, the 
next time your boss asks, “What do you do with your time?” you can produce a text file 
and show him.  

You can open the archive using any word processor or text editor program.  The file will 
list the date, time, subject and notes of an event followed by the type of notification used, 
the duration, the advance warning and the recurring interval for the event.  The 
DOW/NoDOW and EOM/NoEOM statements refer to whether or not you checked the 
“Keep Day of Week” and “From End of Month” boxes. 

Tabs are automatically inserted between the fields.  You may import the text file to other 
programs or into a database.

Creating Archives
As with appointment files, you are not limited to a single archive.  You may create other 
archives for personal events or for keeping tabs on what you’ve done with which client.  If 
you share your Macintosh with another worker, you can each keep a separate archive.

1)   Open Alarming Events.

2)   Pull down the Alarming Events menu and hold the mouse button down with the cursor
on “Archive Files”.  The sub-menu will appear.  

3)   Slide the cursor down and release the mouse button when “Edit Menu…” is 
highlighted.  The Edit Archive File Menu dialog box will appear.

4)   Click the “New” button.  The Save New File As: dialog box will appear.  Type in a 
name and use the buttons and folders to select a location for the file.  Click the “Save” 
button.

5)   The Edit Archive File Menu dialog box will reappear with your new archive highlighted 
and its hierarchical location shown in the lower window.

6)   Click the “Done” button to close the Archive File dialog box.  The new Archive will be 
listed in the Archive File sub-menu.

Switching archives
To switch to a different archive, simply select it from the Archive File sub-menu.  The 
current archive is identified with a check mark in the sub-menu.

Adding Archive files to the sub-menu
To add another file to your the Archive Files sub-menu, open the Edit Menu dialog box, 
select the file you wish to add and click the “Add” button.  Using the Drive button and the 
folders in the Open dialog box, locate the file you wish to add to the menu.  Double-click 



the file.  The Edit Archive File Menu dialog box will reappear with the file listed.  Click the 
“Done” button.

Removing archives
To remove an archive from the Archive Files sub-menu, open the Edit Menu dialog box, 
select the archive you wish to remove and click the “Remove” button.

Locating archive files
If an archive file has been moved into a different folder or renamed, its name will be 
dimmed in the Archive File sub-menu.  It cannot be used until you identify the new name 
or location with the “Locate” button.

Open the Edit Archive File Menu dialog box, click on the dimmed file name and click the 
“Locate” button.  A Find File dialog box will appear.  Use it to find and highlight the file.  
Click “Open”.  If the file was renamed (at the Finder), the new name will now appear in the
Archive File sub-menu.

Printing Appointment Files

If you are leaving the office, it would be handy to have a list of your upcoming 
appointments.  The “Print” command in the Alarming Events menu lets you print a partial 
or full copy of your appointment file.

1)   Select the appointment file you wish to print from the sub menu that appears when 
“Appointment Files” is selected from the Alarming Events menu.

2)   Select “Print” from the Alarming Events menu.  A dialog box will appear.  (Different 
dialog boxes are used for different printers.)

3)   Click the “Options” button.  The Print Options dialog box will be shown.

4)   Click the button for the portion of the file you want to print.  If you click the “Events in 
Date Range” button, you may type the dates in the month, date and year fields when they 
are highlighted or adjust the dates by clicking the up and down arrows.

5)   Check the “Show Recurring Events” box if you wish recurring appointments to be 
printed.  If “Show Recurring Events” is not checked, the event will only be listed on the 
date it was originally entered.

6)  You can also specify the events to be printed based on the type of notification they 
have been assigned.  Check the boxes along the right side to print events that are 
announced with the Notification Pop-up, the Flashing Alarm, Timed Events, To Do items 



or events already marked as Done.

7)   Click the “OK” button.  The Print dialog box will return.  Set it according to the printer 
you are using and the number of copies you need and click the “Print” or “OK” button.

Each date with an event scheduled will cause the small calendar to be printed with the 
date outlined.  Events are listed with their Event Type icons and the contents of the fields 
(in the Single Day window) associated with the event.

Importing and Exporting Events

Importing Events
You can import text files, Smart Alarms™ files and CalendarMaker files to Alarming 
Events. Select “Import Events…” from the Alarming Events menu and select the file to 
import from the Open dialog box that appears.

The events in the file will be added to your currently selected appointment file.

Exporting
Besides printing out your appointment file, you can also export it as a text file or to 
another application such as CalendarMaker.

Note to CalendarMaker™ users:  If you have CalendarMaker from CE Software, you can 
easily produce a printed calendar listing your events.  Just  use the “Export” command to 
name and save the file in the CalendarMaker format.  Then open CalendarMaker and 
open and print your calendar as described in the CalendarMaker manual.  

1)   Select “Export Events…” from the Alarming Events menu.  The Export dialog box will 
appear.

2)   Select a location for the file using the buttons and the folders in the scroll bar window 
and type a name for the file.

Beneath the “Save the new file as:” field are listed the types of events that will be placed 
in the new file and the format (CalendarMaker or tab-delimited Text File) in which the file 
will be saved.

If you need to alter the format or events to be saved, click the “Options” button. The 
Export Options dialog box will appear.  Use the buttons to select the format desired, the 
events (either all events or those within a date range you specify) and the fields of the 
Single Day window you wish to have displayed.

Note:  We recommend you only include the date, time and subject fields when exporting 



to CalendarMaker.  Otherwise dates with more than one or two events may not have all 
the events listed in the date box due to the limited space.

If you wish recurring appointments to be included in the file, check the “Show Recurring 
Events” box.

Click “OK” to accept the Export Options and close the Export Options dialog box.

3)  Click the “Export” button in the Export dialog box.


